
EG1003: Help’s and How To’s: Revit Tutorial 
 
 
Completion of this tutorial is required for milestone 1. Include screenshots of it in your Milestone 

1 presentation.  

 

Helpful Mouse Tips: 
 
To zoom in and out, scroll with your mouse. 
 
To highlight something, click the object or click and drag over the object (like in AutoCAD). To 

highlight multiple objects, click on one, hold “ctrl”, then click the rest you would like to highlight. 
 
To pan around your view, click/hold your mouse’s scroller and move your mouse. 
 
In your 3D view, to pan and rotate at the same time, hold “Shift”, and click/hold your mouse’s 

scroller, then move your mouse. 
 
 
 
Downloading Revit: 
 

Before beginning the tutorial, please download the student version of Revit 2019 (not 

2018) on your computer from the Autodesk website (https://www.autodesk.com/education/free-

software/revit). This version is free, and you will be using your NYU email to create an Autodesk 

account. Follow the steps on that link to download Revit. After it has downloaded, you should be 

able to complete the tutorial. 

 

https://www.autodesk.com/education/free-software/revit
https://www.autodesk.com/education/free-software/revit
https://www.autodesk.com/education/free-software/revit
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1. Introduction 
 

Open Revit. Under the home page, there is a column labeled “Projects”. Select 

“Architectural Template”. Each template is for a different type of design. For example, if you want 

to design a plumbing system, you would open up a Mechanical Template. We will be working in 

the Architectural Template for most of the project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

This is your home screen for a project. On the left, there is a column called 

“properties”, and below it is a column called “project browser”. At the top of this window is 

the tool bar. 



2. Setting Levels/Getting Started 
 

The most important part of getting started is defining the levels of your project (the story 

heights for the building). 
 

Go to the Project Browser column on the left, and double click on the East Elevation. 

This will open up a window that shows the view of the East elevation of your project. You can 

switch between any view by double clicking on the level or elevation name. A new window of 

that view will open (don’t worry—your first window isn’t gone, it’s just behind your new 

view!).  



 
When your window opens, double click on the current height and name of the existing 

levels to change them. Remember to check your units when you are typing in numbers! To add 

a new level, click the black and white circle icon in the toolbar under “datum”. For a shortcut, 

you can also type “LL” and your cursor will automatically be ready to draw a new level. To 

delete a level, just click on it and press “delete”. Once you have set your levels, you can start 

building!  
 
 
 
 
 
 

 

Add a new level 
 
 
 
 
 
 
 
 

 

Adjust current level 



3. Views 
 

If you would like to view all of your views at once, you can go to the “View” tab in the 

toolbar, go to the “Windows” subtab, and click the icon with one rectangle on top of the other. 

This is the “Tile Windows” option. You can also just type “WT” on your keyboard as a shortcut. 
 

To view your 3D model, go to the “View” tab in the toolbar, under the “Create” subtab, 

click “3D View”. 
 

When you highlight/select one object in your project, it is selected in ALL windows. If 

you have all windows open at once and select an object, it will be highlighted in each window. 

This is helpful in locating or viewing certain objects’ placement. 
 

Along the bottom of your window is a toolbar with various symbols. Hover over each 

symbol to figure out what each one does. The most important functions in this toolbar are the two 

symbols highlighted below.  
 
 
 
 

The first highlighted symbol is the visual style of your drawing. Wireframe is the most 

useful style to build in because you can see through all of your objects. 
 

The second 2 highlighted symbols work hand in hand. If you would like to hide certain 

objects while you are drawing, right click on it and click “hide in view”. You can also select 

objects and then click the glasses symbol to hide an object. Hiding an element means only hiding 

the object(s) you selected. Hiding a category means hiding every object that is the same as the 

object you selected. 
 

The lightbulb symbol, when clicked, shows everything that you have hidden in pink, along 

with your existing structure (like the upside down in Stranger Things!). These two functions are 

helpful when you want to build on the interior of your structure, but your walls are blocking your 

vantage point. 
 

A helpful tool that you can utilize throughout your project is something called the “Section 

Box”. 



4. Building 
 

In the Project Browser column, go back to your 1
st

 level under “Floor Plans”. You should 
always be building from the ground up, so start at Level 1. 
 

To start, build your walls under the “Wall” function in the “Architecture” tab of the 

toolbar. Build an Architectural Wall. When you click on the function, a new tab called “Modify” 

should appear on the far right of the toolbar. This happens for any new structure you are building. 

Click what type of line or shape you would like to draw and draw it on your view.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If you made a mistake in your initial drawing, you can always double click on the 

dimension in blue and change it manually by typing in the correct value. Once you are done 

modifying the wall, click the “esc” button. 



 
After you have created walls for your structure (just level 1), you can add floors, ceilings, 

doors, and windows. Just click on the structure you would like to add and place it on your 

structure. 
 

For floors and ceilings, you will need to provide a “boundary” that your floor or ceiling 

will follow. This boundary is the perimeter of your building that you created when you build 

your walls. 
 

Click “Floor”, and under the modify tab, it will prompt you to pick a line type to draw 

your boundary. Simply click on your walls that you created, then click the green check mark. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The procedure for ceilings is almost the exact same. After clicking “ceiling” under the 

“architecture” tab, it will prompt you to create an automatic ceiling or if you want to sketch the 

ceiling manually. If you have a simple wall design (such as a single rectangle), you can use an 

automatic ceiling. If you have a more complex wall design shape, click sketch ceiling. The 

procedure to sketch your ceiling boundary is the same as the floor boundary. 



 
DISCLAIMER: Do not create your roof until you are completely done with you project 

and that is the final piece missing. This includes adding stairs, furniture, doors, and 

windows before entering the roof and ceiling. 

 

To insert a roof onto your building, click “roof” in the architectural tab and draw its 

footprint (same as a boundary). Revit will ask if you would like to move the roof you are about 

to create to the next level (Level 2), click yes. After drawing your roof footprint and clicking the 

green check mark, Revit will ask you if you would like to attach the highlighted walls to the 

roof. Click yes. NOTE: you MUST do ceilings and floors BEFORE you build your roof.  



Once you click the green check mark, your roof will be created. It should look similar to 

this:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you would like to change the height of the roof, click and drag the arrows at the peak 

of the roof. 
 

To install stairs, go to the level that you would like your stairs to start on. For this example, 

we will be starting on level 1, building stairs up to level 2. Double click on “Level 1” under “Floor 

Plans” in the Project browser column. Select the Stair command in the Architectural tab of the toolbar. 

Once you’ve placed your stairs on level one, click the green check mark and navigate to your 3D 

view. Your stairs are visible but are coming right out of your floor on the second level. 
 

NOTE: to do this next step, you must build a floor on your second level. 
 

Double click on the ceiling you created on your first floor (this can be easily done in 

the 3D view but may be hard to locate in your level 1 plan view). You should now be in the 

modify mode for your ceiling. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Using the compass in the top right of your screen, click on “TOP” to get a overhead view 

of your stairs. In the “Modify | Edit Boundary” tab of the toolbar, click the rectangle icon and 

draw a rectangle around your stairs, so that you make a “cut” or “gap” in your floor.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click the green check and do the same procedure for the ceiling. When you’ve finished, 

your stairs should look like this. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

NOTE: This is a 3D view, with one wall temporarily hidden so that you can see inside the 

building. 
 

You can modify your stairs’ length, height, and other dimensions by double clicking them. 



5. Modifying Objects & Changing Properties 
 

When you select an object, its specific properties show up in the properties column on 

the left. For example, if you click on a door that is in your structure, the properties toolbar will 

show its type along with other details. If you would like to change something about the door 

you are using, click “Edit Type”. Here you can change dimensions, color, material, etc. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

If you would like a completely different door (this procedure also applies to windows, 

walls, columns, etc.), click “door” under the architecture tab as if you were going to add a new 

door to the project. Under the “Modify” tab on the toolbar is a command called “Load Family”. 

Click it, and this window should appear: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Navigate through the folders to find which object you would like to load into your project. 

Once you have clicked it and approved, click “Open”. Revit will ask you which type/dimensions 

you want. Select the one you want and click “Ok”. Now when you click the “door” command, you 

will have multiple doors to choose from. If you click the drop down (highlighted in red), you will 

see all of the options you have, including the families you downloaded. 

  



 
If you would like to import an object such as a door, chair, tractor, tree (anything you 

want!), that is not stored in your computer’s Revit folders that come with the program, navigate to 

the “Insert” tab on your toolbar. Instead of clicking “Load Family”, as per usual, start typing in the 

search bar called “Search Autodesk Seek” for the item you are trying to find. Try using “chair”. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Revit will take you to a website called BimObject. This website is similar to Thingiverse 

for 3D printing. Companies upload specifications for objects that they create/manufacture to this 

website for engineers and architects to use it in their designs. Click on the object that you would 

like to insert into your design. Click on the download button. BimObject will prompt you to make 

an account if you have not already. Choose to sign in with your google account and use your nyu 

information. After logging in, download the file of the chair that you’ve picked, and click the 

revit version from this pop up: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The following window will open on the bottom of your screen. Click “Open”. 

  
 
 
 
 
 
 

 

You will then be taken back to Revit. When the following window opens, click 

“Upgrade the Model”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Your file will open, and you should see the object you selected on BimObject.com as if it were 

its own model that you can change, just like your building. Go to it’s 3D view. If you do not see your 

object, and only see a box, that it because each object once downloaded is covered in one. Click 

the box and press delete. You should now see your object. Click “Load into Project”, and you will be 

able to place it wherever you’d like. To find this object and other objects you have loaded into your 



project, go to the Architecture tab, click “Component”, and in your Properties tab, if you click the 

dropdown for the object, all of your imported objects should be there. 

 

Helpful tip: if you are trying to rotate an object or component, click it so that it is 

highlighted 

 



6. Electrical Plan 
  

When adding an electrical plan onto Revit one needs to make copies of the intended floors. 

To do this you first right-click under the desired floor plan you are trying to make a copy of under 

the “Project Browser” (in this case Level 1). Then select “duplicate view” and “duplicate”. 

 

 
 

 After the new plan is created right-click the “Level 1 Copy” and rename it into “Electrical 1” 

 

 Next you must insert all of the desired electrical fixtures such as lights and switches. To do this 

you need to go onto the “insert” tab and select the following: 

• Lights: Load Family →Lighting →MEP →Internal/External 

o Then select your desired light based on preference and open 

• Switches: Load Family→ Electrical →MEP →Electric Power → Terminals  

o Select your desired switch and open 

 

 To insert the electrical equipment, under the project browser, click families → Electrical 

Fixtures → Switch. Then drag and drop the switch into the electrical floor plan. It is important to 

note that the switch needs to be placed on a wall. 

 

 To add lights there needs to be a ceiling on that floor. The ceiling has to be a “GWB on MTL. 

Stud” ceiling. Then under the “Electrical 1” plan go to the properties tab and select “Range: Base 

Level” and change it from “None” to “Level 1” and change the “Underlay Orientation” to “Look 

up” 



 
 

 

 Then under the “Project Browser” select the light you want to drag and drop onto the plan. If 

you want to place the light on the wall just drag it onto the wall and it will automatically snap on. 

If you want to add the light onto the ceiling, you need to click “Placement” then “Place on Face”. 

If you followed all the previous instructions, you can now place the light onto the ceiling. 

 

 

 

 

The red rectangles highlighting the ceiling and wall lights as well as the switch.  



 
 

  

 Finally, you need to connect everything with a wire. To do so go under the “Systems” tab and 

select “wire”. 

 

 
 



 
 

 Once the wire is selected you connect all the fixtures by selecting the purple circle with the x 

through it. Each electrical fixture has one and you connect each of the points with the wire in order 

to properly connect an electrical plan. Below is a complete electrical plan with all of the lights 

connected to one switch 

 

 
  



7. Plumbing Plan  
 

In order to add Plumbing to your building, you need to do something called “Link” 

your Revit file. 
 

Save your current file, the original architectural template that you’ve been working on. 
Close that project (make sure there are no hidden windows of the architectural template open) 
and go back to the homepage where you can choose to start a new project. Go to the Revit Icon 
and click “New” and “Project”. Because we are now working on MEP, we will open up a 
Mechanical Template instead of an Architectural Template. Click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A new Project will open, and if you look at your project browser, notice that you still 

have floor plans and ceiling plans (etc), but they are now labeled “1 – Mech”, etc. 
 

We will now “Link” our original Revit model into our new project. Go to the “Insert” tab 

on your toolbar and click “Link Revit”. The following window will open. Select your original 

project and open it. (Make sure it is not open in any other windows. It will not link if it is open. 

Remember to use the command “WT” to see all the windows you have open.) 

 

To create a plumbing plan, make sure you are working under Plumbing and not HVAC.  



 

 

 

 

 All plumbing fixtures (toilets, sinks, showers, etc.) must be reinserted in the mechanical 

template. Simply insert plumbing fixtures over the original as linking a file does not allow proper 

access to the fixture. When inserting the fixtures, they should snap into place over the original 

fixture. Make sure you are inserting MEP plumbing fixtures not architectural. 

 

To create a pipe, go to “System” and select “Pipe”. 

 



 

Change the diameter of the pipe to 6” and offset to 0”. Also make sure that the system type 

is set to sanitary this can be changed in the properties panel under the mechanical section.  

 

 

Create a sanitary pipe by going from one corner of the building to the “street.” 

 

 

 

Select the plumbing fixture you would like to connect to the pipe inserted earlier. Each of 

the plumbing fixtures has an “out” pipe option. Select the “out” option, this will auto generate a 

pipe. Change the pipe diameter to the desired size and select inherit elevation. Click on the fixture 

first and then the pipe originally drawn. 

 



 

Repeat for the remaining plumbing fixtures.  

 

 



 


